Braniff Graduate School of Liberal Arts

Master’s Thesis Handbook


Enrolling in Thesis Research (6 Credit Hours)
Prior to enrolling in Thesis Research, you must complete all coursework, the comprehensive exam, and the foreign language requirement. Additionally, you must submit a Master’s Thesis Proposal Approval form along with the recommendation of your program director to the graduate dean. The graduate dean will approve your thesis proposal and readers only after you have completed all the previously listed requirements. Thesis Research is only taken once, but you may enroll in Graduate Readings for any subsequent semesters of work. Upon completion of your thesis and its approval by your readers, your first reader will change the grade for Thesis Research.

The Thesis
[bookmark: _heading=h.gjdgxs]A thesis is written under the direction of a faculty member and is not a free-lance operation for which one later seeks endorsement. Although readers are assigned by the graduate dean with recommendation from your program director, you are encouraged to seek out a potential first reader and to discuss potential topics with this faculty member prior to submitting your thesis proposal. This collaboration is more likely achieved if you have prepared the way in previous course work, term papers, and serious discussion on the topic with members of the Institute faculty.
When formulating your proposal, it is important to remember that a thesis is not a question, matter of fact, or an opinion on a topic. Instead, it is a debatable answer to a question and is supported by research, reasoning, and persuasive writing. Your thesis should make a clear, definable, arguable claim that takes a particular stance and justifies discussion. The goal is to create a work that could be published as an article in a scholarly journal. The work itself should be between 40 and 80 pages in length and must follow the formatting requirements on the page below.

Completing the Thesis
[bookmark: _heading=h.30j0zll]When you have finalized all changes to your thesis and it has been approved and graded by both of your readers, you must upload your completed thesis to UDspace and ProQuest. To submit your thesis to UDspace, open the EDT submission form found here or below, and complete the form. After you have completed the form, you will download it and submit it, along with a PDF copy of your completed thesis to archives@udallas.edu. You must also include a confirmation email from your advisor, chair or director of the acceptance and completion of your work. Your advisor, chair or director can directly email the acceptance and completion confirmation to archives@udallas.edu, or, if it is emailed to you, download it and submit it along with your completed EDT submission form and a PDF copy of your completed thesis to archives@udallas.edu, 
To submit your dissertation to ProQuest, visit ProQuest ETD Administrator - Home and follow the directions provided on the site. An additional guide can be found below. Please contact archives@udallas.edu with any questions regarding either submission process. 



Formatting Overview and Requirements for Final Thesis

The following details govern the cosmetic presentation of your thesis. The Graduate Office does not have a thesis secretary, so you alone are responsible for seeing that your thesis meets the standards for proper format. Also, you are responsible for checking that your thesis displays properly in .pdf format. 
The final copies of your thesis should adhere to the most recent edition of either The Chicago Manual of Style or the MLA Handbook for Writers of Research Papers.
Recommended Document Order and Page Number Guidelines
	Section
	Page Numbering

	Abstract
	No Page Number

	Title Page
	No Page Number

	Copyright Page
	No Page Number

	Epigraph (optional)
	No Page Number

	Table of Contents
	No Page Number

	List of Illustrations (if applicable)
	No Page Number

	List of Tables (if applicable)
	No Page Number

	Preface or Acknowledgements (optional)
	Page number starting from Abstract (i)

	Introduction (optional)
	Page numbering continued from Preface/Acknowledgements (ii)

	Body of Thesis
	Start on page (1) 

	Appendix (if applicable)
	Continue numbering from Body (2)

	Notes
	Continue numbering from Appendix (3)

	Glossary (if applicable)
	Continue numbering from Notes (4)

	Bibliography
	Continue numbering from Glossary (5)

	Index (if applicable)
	Continue numbering from Bibliography (6)







Further Details
Pagination
· As displayed above, no page number should appear on the abstract, title page, copyright page, dedication, epigraph, table of contents, list of illustrations, or list of tables, although they will be counted toward your final page count. 
· Beginning with the first page of the Preface/Acknowledgements, pages should be numbered in lower case Roman numerals, although the numerals should begin with the page number that follows the total pages thus far in the dissertation, from the abstract forward. 
· Use Arabic numerals to paginate the text, appendix, endnotes, glossary, bibliography, and index. 
Margins
· Left: 1”; Right: 1”; Top and Bottom: 1”
· Page Numbers at least ¾” from edge of page.
Font
· Embedded fonts required (guide). Post Script Type 1 fonts required.
· Any legible font equivalent in scale to 12pt. Times New Roman accepted. Script, italic, or ornamental fonts are not acceptable. However, italicized font may be used for non-English words and quotations.
· Use the same font size throughout the entire text. 
· Font color must be black, without highlighting.
· Font requirements apply to all text including captions, footnotes, citations, etc.
Line Spacing
· Double Space: Abstract, Dedication, Acknowledgements, Table of Contents, and Body of the manuscript, except for quotations as paragraphs, captions, items in tables, lists, graphs, charts. 
· Single Space: footnotes/endnotes, bibliographic entries, lists in appendices.




   


          BRANIFF GRADUATE SCHOOL OF LIBERAL ARTS

MASTER’S THESIS PROPOSAL APPROVAL FORM


(Student: Please fill out and submit to your Program Director. You will be notified upon approval.)

   Student ____________________________________________                Date _____________
Program _____________________________________________________________________
Tentative Title of Thesis ________________________________________________________
Short Outline of Topic __________________________________________________________
  ______________________________________________________________________________  
  ______________________________________________________________________________ 
  ______________________________________________________________________________
  ______________________________________________________________________________
  ______________________________________________________________________________
  ______________________________________________________________________________  
  ______________________________________________________________________________
																																																																														
													

I approve the proposed thesis and recommend the appointment of these two readers: (a third reader may be appointed if appropriate.)

1.													
2.													
(Student: Please be aware that the Program Director may revise the listing of readers.) 

Program Director							Date				

Upon completion, please send this form to the Braniff Graduate Dean’s Office.
---------------------------------------------------------------------------------------------------------------------

I approve the proposed thesis and the Committee as suggested.

Graduate Dean							Date				











THE BRANIFF GRADUATE SCHOOL

OF THE

UNIVERSITY OF DALLAS




THE TITLE OF YOUR THESIS

by

YOUR FULL NAME


B.A., THE NAME OF THE UNIVERSITY, DATE




A thesis submitted to the Graduate Faculty of the University of Dallas in partial fulfillment of requirements for the degree of Master of Arts in the Department of (Discipline).


DATE



Approved by the Examining Committee:

[First Reader]
[Second Reader]









[bookmark: bookmark=id.gjdgxs]
[image: Logo  Description automatically generated ]
Electronic Theses and Dissertations Submission Form
To submit your completed thesis or dissertation to the University of Dallas’s institutional  repository,  open  this  document  in  a  browser  window (from https://udallas-ir.tdl.org/handle/20.500.14026/2057, click on the View/Open link). Each of the fields is editable in the browser; fill out this form in its entirety and download it. Email the completed form with a PDF copy of your approved work  to  archives@udallas.edu.  All submissions to the University Archives must include confirmation from your program of the acceptance of your work: either the signed Dissertation Defense form or, for a thesis, an email sent directly to archives@udallas.edu from an advisor, chair, or director.  The  acceptance  confirmation  and this completed form will  be kept  on  file,  but  will  not  be  available  to  the  public.  Please direct any questions to the University Archivist at archives@udallas.edu.
Author’s name (please NOTE of this name you provided as you will use the same name in tracking and organizing your thesis and future research and articles):  _______________________________________________
Email address: ____________________________________________ Department: _____________________________________________ Thesis or Dissertation advisor: _________________________________
Committee members: 			_____________
Degree:   [image: ] MA       [image: ] MFA	   [image: ] MBA	[image: ] DBA	[image: ] PhD
Thesis or Dissertation title:

     At least 4 and no more than 12 keywords describing the subject of your document:


Abstract or Summary (maximum 200 words; if doctoral work, maximum 300 words):

[bookmark: Institutional_Repository_Embargo]Institutional Repository Embargo
Please select whether or not to embargo your thesis or dissertation, placing a “hold” on your document that will prevent the University Archives from releasing it to the institutional repository or any other database. If you are unsure of which option to choose, please consult with your advisor to determine the best choice for your work. Additional information may be available from the University Archivist (archives@udallas.edu) or through the Reference Team at the Cowan-Blakley Memorial Library (reference@udallas.edu).

You may elect to place an embargo on your dissertation or thesis for up to 3 years.


None :	[image: ]	The work will be published after approval.  (default)


1 - year Hold :




2 - year Hold :




3 - year Hold:

The full text of this work will be under restricted access in the University of Dallas's institutional repository for one year from the semester of graduation. Allows author time to publish and fulfill publisher embargo requirements.

The full text of this work will be under restricted access in the University of Dallas’s institutional repository for two years from the semester of graduation. Allows author time to publish and fulfill publisher embargo requirements.

The full text of this work will be under restricted access in the University of Dallas’s institutional repository for three years from the semester of graduation. Allows author time to publish and fulfill publisher embargo requirements.



If you would like to extend the embargo beyond this time period, at the end of the original embargo please email archives@udallas.edu to request up to three additional years of “holding” to your dissertation or thesis. This process can be repeated, if necessary.


Initial here to acknowledge the above: 	

[bookmark: University_of_Dallas_Licensing_Statement]University of Dallas Licensing Statement for Institutional Repository
By signing and submitting this license, I grant the University of Dallas ("Institution"), my academic department ("Department"), and the Texas Digital Library ("TDL") the non-exclusive rights to copy, display, perform, distribute and publish the content I submit to this repository ("Work") and to make the Work available in any format in perpetuity as part of an Institution, Department, or TDL repository communication or distribution effort. I understand that once the Work is submitted, a bibliographic citation to the Work will remain visible in perpetuity, even if the Work is updated or removed. I understand that the Work's copyright owner(s) will continue to own copyright outside these non-exclusive granted rights.

I warrant that:
1. I am the copyright owner of the Work, or
2. I am one of the copyright owners and have permission from the other owners to submit the Work, or
3. My Institution or Department is the copyright owner and I have all required permission to submit the Work, or
4. Another party is the copyright owner and I have permission to submit the Work.
5. Based on this, I further warrant to my knowledge:
6. The Work does not infringe any copyright, patent, or trade secrets of any third party,
7. The Work does not contain any libelous matter, nor invade the privacy of any person or third party, and
8. That no right in the Work has been sold, mortgaged, or otherwise disposed of, and is free from all exclusive claims.

I agree to hold the Institution, Department, TDL and their agents harmless for any liability arising from any breach of the above warranties or any claim of intellectual property infringement arising from the exercise of these nonexclusive granted rights.




Signature	Printed Name	Date


Reminder: all documents must be submitted as PDFs. No other formats can be accepted.


Uploading a Thesis or Dissertation to ProQuest
This document will guide students through the steps for submitting their completed thesis or dissertation to ProQuest. Prior to beginning the online process, a few preparations should be made.
1. Save the thesis/dissertation in PDF format. Double check the document to ensure that all parts are displaying properly in PDF form.
	2. Prepare a written abstract saved as a separate PDF.
	3. Gather any supplemental files (audio, video, spreadsheets, etc.).

[image: ]
Do not proceed with submitting your thesis until you have in hand a confirmation/approval email from your committee advisor, chair or director of the acceptance and completion of your work. Your advisor, chair or director can directly email the acceptance and completion confirmation to archives@udallas.edu


Students will then visit ProQuest ETD Administrator - Home to begin the process of uploading their thesis or dissertation. On the home page click sign up and get started, which is an orange box located near the bottom of the page. Then, select University of Dallas from the list of available schools. This will take you to create a new student account. (Please NOTE of your registered account name as you will use the same account in tracking and organizing your thesis and future research/articles). After creating a new student account, ProQuest will walk students through the process of submitting all of the necessary information. Items to be submitted are as follows:
	1. PDF of thesis or dissertation
	2. Abstract
	3. Supplemental Files
	4. Names of committee members
	5. Selection of subjects from a subject category list that is provided on the website

After uploading all of the relevant information, ProQuest will take students through publishing options and copyright agreements. It is important to note that there is no cost to students for submitting their work to ProQuest. ProQuest does provide optional services for bound print copies and filing additional copyright paperwork, among other services, and each of these optional services have an associated fee if selected. Additionally, the copyright is non-exclusive. 
When students reach the university agreement page, they will click to accept the agreement at the bottom of the page. The form on this page is not fillable. Students can print this page off, fill it out, and turn it in to the library or scan and email it to chohertz@udallas.edu. Students also will have access to this page through the instructions for uploading their thesis/dissertation to UDigital Commons and may complete it during this process instead. The University Agreement form does not need to be submitted twice. 
After students have finalized their submission and submitted their work to ProQuest, it takes an average of 4-6 weeks after submission to ProQuest before the work will be discoverable on ProQuest. 

[bookmark: bookmark=id.30j0zll][bookmark: _GoBack]
How to Embed Fonts

USING MICROSOFT WORD ON A PC

To embed your fonts in Microsoft Word 2010
1.    Create your manuscript using a TrueType font. Recommended fonts include Times-New Roman and Helvetica.
2.    In the File pull-down menu click on Options.
3.    Choose Save on the left sidebar.
4.    Check the box next to Embed fonts in the file.
5.    Click the OK button.
6.    Save the document.

To embed your fonts in Microsoft Word 2007
1.    Create your manuscript using a TrueType font. Recommended fonts include Times-Roman and Helvetica.
2.    Click the circular Office button in the upper left corner of Microsoft Word.
3.    A new window will display. In the bottom right corner is a button, Word options. Click the Word Options button.
4.    Choose Save from the left sidebar.
5.    Check the box next to Embed fonts in the file.
6.    Click the OK button.
7.    Save the document.
To embed your fonts in earlier versions of Microsoft Word
1.    Create your manuscript using a TrueType font. Recommended fonts include Times-Roman and Helvetica.
2.    On the Tools menu, choose Options
3.    Click the Save tab.
4.    Select the Embed TrueType fonts check box.
5.    Save the document.





USING MICROSOFT WORD ON A MAC

Microsoft Word 2008 on a Mac OS X computer will automatically embed your fonts while converting your document to a PDF file. Please note that previous versions on Microsoft Word on a Mac are not able to embed fonts.
Another option you might consider is using OpenOffice (which embeds fonts automatically while converting to PDF) or using a PC to embed fonts in your manuscript.










USING ADOBE ACROBAT PROFESSIONAL

Alternatively, if you have Adobe Acrobat Professional available to you, you can follow the excellent instructions provided by the Graduate Thesis Office at Iowa State University:
1. Open your document in Microsoft Word.
2. Click on the Adobe PDF tab at top. Select Change Conversion Settings.
3. Click on Advanced Settings.
4. Click on the Fonts folder on the left side of the new window. In the lower box on the right, delete any fonts that appear in the Never Embed box. Then click OK.
If prompted to save these new settings, save them as "Embed all fonts."
5. Now the Change Conversion Settings window should show "embed all fonts" in the Conversion Settings drop down list and it should be selected. Click OK again.
6. Click on the Adobe PDF link at the top again. This time select Convert to Adobe PDF. Depending on the size of your document and the speed of your computer, this process can take 1-15 minutes.
7. After your document is converted, select the File menu at the top of the page. Then select Document Properties.
8. Click on the Fonts tab. Carefully check all of your fonts. They should all show "(Embedded Subset)" after the font name.
9. If you see "(Embedded Subset)" after all fonts, you have succeeded.
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